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CC2564C TI Dual-Mode Bluetooth® Stack
on STM32F4 MCUs

Wi} TEXAS INSTRUMENTS

ABSTRACT

The CC2564C dual-mode Bluetooth® stack on STM32F4 microcontrollers (MCU) software
(CC2564CSTBTBLESW) for Bluetooth + Bluetooth low energy from Tl enables the STM32® Arm® Cortex®-M4
processor and includes single-mode and dual-mode offerings implementing the Bluetooth 5.1 specification. The
Bluetooth stack is fully qualified (QDID 85355 and QDID 69886) and provides simple command-line applications
to help speed development, and has MFi capability upon request.

For a complete evaluation solution, the CC2564CSTBTBLESW software development kit (SDK) works directly
with the STM3240G-EVAL hardware development kit. The stack for the STM32 MCU is certified and royalty free
(CC2564CSTBTBLESW).

The software works with CC256xCQFN-EM board. It also provides complete Bluetooth BR, EDR, and low-
energy HCI solution, reducing design effort and enabling a faster time to market. The CC256xCQFN-EM
includes Tl's dual-mode Bluetooth 5.1 compliant solution. The devices provide best-in-class RF performance
with a transmit power and receive RX sensitivity that provide approximately two times the range of other
BLE-only solutions. TI's power-management hardware and software algorithms help save a significant amount of
power in common Bluetooth BR, EDR, and low-energy modes of operation.
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1 Features

.

.

.

.

.

.

Supports dual-mode Bluetooth 5.1 — Bluetooth certified and royalty free

Offers a fully qualified Bluetooth stack (QDID 172096 and QDID 172097)

Offers thread-safe operation

Supports both threaded (RTOS) and nonthreaded (No OS) environments (sample applications use
FreeRTOS)

Offers a fully documented API interface

Works with any STM32F4 MCU

Offers sample applications for the STM3240G-EVAL MCU Development Kit supported by CC256XEM-
STADAPT

Offers the capability to disable or enable protocols and profiles

Supports Keil® and IAR Embedded Workbench® IDEs

2 Bluetooth Profiles

Classic Profiles

.

Advanced audio distribution profile (A2DP): Standard A2DP implementation and Assisted A2DP (A3DP)
implementation with internal SBC encoding/decoding on the CC2564C device
Audio and video remote control profile (AVRCP)

Generic access profile (GAP)

Generic audio and video distribution profile (GAVDP)

Headset profile (HSP)

Hands-Free Profile (HFP)

Human-interface device (HID) profile

Message access profile (MAP)

Phonebook access profile (PBAP)

Serial port profile (SPP)

Low-Energy Profiles

Alert notification service (ANS)

Alert notification profile (ANP)

Battery service (BAS)

Cycle speed and cadence service (CSCS)
Device information service (DIS)

Find me profile (FMP)

Generic access profile service (GAPS)
Generic attribute profile (GATT)

Health thermometer service (HTS)
Health thermometer profile (HTP)
Heart rate service (HRS)

Heart rate profile (HRP)
Human-interface device service (HIDS)
HID over GATT profile (HOGP)
Immediate alert service (IAS)

Link loss service (LLS)

Phone alert state service (PASS)
Phone alert state profile (PASP)
Proximity profile (PXP)

TX power service (TPS)

MFi Support

.

iAP Protocol (iIAP 1/iAP 2)
— Provided as an add-on upon request

SWRU498B — FEBRUARY 2017 — REVISED DECEMBER 2021 CC2564C Tl Dual-Mode Bluetooth® Stack on STM32F4 MCUs 3
Submit Document Feedback

Copyright © 2021 Texas Instruments Incorporated


https://launchstudio.bluetooth.com/ListingDetails/134074
https://launchstudio.bluetooth.com/ListingDetails/RedirectFromQdid/172097
https://www.ti.com
https://www.ti.com/lit/pdf/SWRU498
https://www.ti.com/feedbackform/techdocfeedback?litnum=SWRU498B&partnum=CC2564C

I3 TEXAS
INSTRUMENTS
Sample Application Overview www.ti.com

3 Sample Application Overview

This demonstration lets you to evaluate Tl's CC2564C Bluetooth device with the STM3240G-EVAL platform.
The CC2564C STM3240G-EVAL Bluetooth applications offer a feature-rich and easy-to-use experience. These
applications let you use a console to send Bluetooth commands, set up a Bluetooth device to accept
connections, connect to a remote Bluetooth device, and communicate through Bluetooth. This demonstration
includes one sample application for each profile with simple command-line sample applications to speed
development.Figure 3-1 shows an overview of the demonstration.

Copyright © 2016, Texas Instruments Incorporated

Figure 3-1. Overview of Demonstration
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4 CC2564CSTBTBLESW Hardware and Software Requirements
A complete evaluation requires the following hardware and software tools from the following list:
Hardware

* One dual-mode Bluetooth CC2564 evaluation board
— CC256xCQFN-EM
*  One CC256xEM Bluetooth adapter kit
— CC256XEM-STADAPT
*  One STM32 experimenter board
— A STM3240G-EVAL board or STM32F4DISCOVERY board

Note

All the sample applications will work out of the box with the STM3240G-EVAL board. Sample
applications must be ported to work with the STM32F4DISCOVERY board. The porting
documentation can be found in the CC2564CSTBTBLESW installation directory.

Because of hardware limitations on the STM32F4DISCOVERY board, the audio and voice
applications cannot be ported to the STM32F4DISCOVERY board for complete evaluation.
Use the STM3240G-EVAL for complete evaluation of the following audio and voice sample
applications:

* A3DP Demo_SNK
* A3DP Demo_SRC

« AUD demo
« HFP demo
* HFPAG demo
* HSP demo

Software

¢ Dual-mode Bluetooth stack

— On STM32F4 MCUs: CC2564CSTBTBLESW
« |DE versions

— 1AR 7.2 or 7.3 for Arm or Keil yVision® 4.70.0.0 or STSW-LINK004 (optional)

Figure 4-1 shows the hardware combination.

CC256XCQFN-EM
CC256XCQFN-EM

CC256XEM-STADAPT Board

STM3240G-EVAL Board

STM32F4DISCOVERY Board
Copyright © 2016, Texas Instruments Incorporated

Figure 4-1. Hardware Combination
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5 Setting Up the Hardware

Using TI's dual-mode Bluetooth CC2564C solution (CC256xCQFN-EM), the STM32 MCU evaluation board
(STM3240G-EVAL or STM32F4DISCOVERY), with the support of the CC256xEM Bluetooth Adapter Kit
(CC256XEM-STADAPT), developers can evaluate both classic and Bluetooth low energy capabilities with the
T1 Dual-Mode Bluetooth stack on STM32F4 MCUs.

To set up the hardware, perform the following steps:

1.

Fit the jumpers onto the adapter board. (Ensure the jumpers are set to the correct position. For more
information on the jumper positions and connections to the specific STM32 boards, see the CC256xEM
Bluetooth Adapter Kit User's Guide and the CC256xEM Bluetooth Adapter Kit Quick Start Guide.

Fit the adapter board on top of the STM32 board. (See Figure 5-3 for an example using the STM3240G-
EVAL board. See Figure 5-4 for an example using the STM32F4DISCOVERY board.)

Optional for Audio and Voice Sample Applications only:

Ensure that the directions of the PCM signals are properly set on the CC256XCQFN-EM to evaluate audio
and voice sample applications. The directions of the PCM signals can be configured so that the PCM port on
the CC2564C device is either PCM master or PCM slave, depending on the sample application. See Table
5-1 to ensure that the R18, R19, and R11 on the CC256XCQFN-EM are properly configured for complete
evaluation of the audio and voice sample applications.

Table 5-1. CC256XCQFN-EM PCM Direction for Audio and Voice Sample Applications

Demo Name(") el R182) R19) R1@)
PCM Role

A3DP Demo_SNK
A3DP Demo_SRC
HFP Demo_AG Slave 0Q DNI DNI
HFP Demo_HF
HSP Demo

All other Sample

L Master (default) DNI 10K Q 0Q
Applications

(1) In addition to the changes listed below, ensure that the proper UART and I12S paths are configured on the CC256XEM-STADAPT
board for each of the Demos. For details, see the CC256xEM Bluetooth® Adapter Kit quick start guide.
(2) DNl indicates Do not install.

Figure 5-1 shows the position of the R18, R19, and R11 resistors on the CC256XCQFN-EM board.

O oE

W JEE B

Copyright © 2016, Texas Instruments Incorporated

Figure 5-1. CC256XCQFN-EM PCM Role Selection for Audio and Voice Sample Applications
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For more details regarding the PCM role selection on the CC256XCQFN-EM board, see the CC256xCQFN-
EM User's Guide and the Dual-Mode Bluetooth® CC2564CQFN-EM Evaluation Board.

4. Ensure that the proper USART port selection is configured on the CC256XEM-STADAPT board. For details,
refer to the CC256xEM Bluetooth® Adapter Kit quick start guide.

5. Install the CC256xCQFN-EM board on the adapter board.

Figure 5-2 shows the setup for the STM32 board.

Copyright © 2016, Texas Instruments Incorporated
Figure 5-2. STM32 General Setup

Figure 5-3 shows an example of the STM3240G-EVAL, the CC256X-STADAPT, and CC256xCQFN-EM boards
combined.

Copyright © 2016, Texas Instruments Incorporated

Figure 5-3. STM3240G-EVAL, CC256X-STADAPT, and CC256xCQFN-EM Combination
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Figure 5-4 shows an example of the STM32F4DISCOVERY, the CC256X-STADAPT, and CC256xCQFN-EM
boards combined.
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Copyright © 2016, Texas Instruments Incorporated
Figure 5-4. STM32F4DISCOVERY, CC256X-STADAPT, and CC256xCQFN-EM Combination

Note

Because of hardware limitations on the STM32F4DISCOVERY board, the audio and voice
applications cannot be ported to the STM32F4DISCOVERY board for complete evaluation. Use the
STM3240G-EVAL for complete evaluation of the audio and voice sample applications:

* A3DP Demo_SNK
* A3DP Demo_SRC
« AUD demo

e HFP demo

* HFPAG demo

* HSP demo
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6 Setting Up the Software

Do the following to set up the software for the demonstration:
1. Navigate to Bluetooth SDK.

Note
When you try to download the SDK, you will be prompted for a Tl login. If you do not have a Tl
login, you must create one.
Create a Tl login (if necessary).
3. Complete and submit the export approval form.

N

Note
Wait for Tl to approve the request. After approving the request, Tl provides you with a link to
download the software.
4. Click Download to download the software.

Note
Tl intends the Bluetooth SDK for use only with the STM3240G-EVAL board. Software
modifications are required for the SDK to work with the STM32F4DISCOVERY board.
Run CC256XSTMNoOSBTBLESW-v4.2.x.x-Setup.exe after the download completes.
Accept the Tl Bluetooth Stack Clickwrap License Agreement.

oo

Note
After accepting the license agreement, the SDK installs to C:\T/\Connectivity\CC256X
BT\CC256xSTM32BluetopiaSDK\v4.2.x.x\.
7. Access the SDK through Start/Programs/Texasinstruments/CC256XBT/
CC256xSTM32BluetopiaSDKv4.2.x.x.

7 Building and Flashing the Bluetooth Code (STM3240G-EVAL)
Sample applications for FreeRTOS and NoOS are available for IAR and Keil.

Perform the following instructions to set up applications on each IDE version.
IAR

1. Navigate to C:\TI\Connectivity\CC256XBT\CC256xSTM32BluetopiaSDK\v4.2.x.x to open the workspace.
2. Select one of the following samples:

* For NoOS, navigate to \NoOS\STM3240G-EVAL\Samples\ for a list of samples.

* For FreeRTOS, navigate to \FreeRTOS\STM3240G-EVAL\Samples\ for a list of samples.

3. Select the demonstration to load onto the device. (This example uses SPPDemo.)
4. Navigate to NoOS.
5. Navigate to EWARM.
6. Select SPPDemo.eww.
Note
The IAR IDE opens.
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7. Select Debug (see Figure 7-1) or Release Configuration from the drop-down menu. (For this example, select
Debug.)
-

& SPPDemo - IAR Embedded Workbench ID
| File Edit View Project Tools Window Help

Files
B SPPDemo ...

[ Application
= (] Bluetopia

F [(1STM32_St.
1 Output

Figure 7-1. AR Drop-Down Menu
8. Select Download and Debug from the Project drop-down menu or click the Play icon. (See Figure 7-2.)

PPDemo - 1AR Embedded WorkbenchDE

| File Edit View Tools Window Help
‘D W@  Addes.. YR E D @
Worpa® | AddGroup..
| ||| Release. Import File List..
||| Files Add Project Connection...
B SPPDem Edit Configurations...
[ Applical
[3Bluetop Remave
[1STM32] E
{3 Output Create New Project...
Add Existing Project...
Options... Alt«F7
Version Control System »
Make F7
Compile Ctrl+F7
Rebuild All
Clean
Batch build... F8
| sPPOemo C-STAT Static Analysis ,
x
pes Log Stop Build Ctrl+Break
<_ | Download and Debug E
Make & Restart Debugger Ctrl+R
Restart Debugger Ctrl+Shift+R
Download 3
SFR Setup
Build Debug Lo
= Open Device Description File >
Download the appl S a——

Figure 7-2. Download and Debug

Note
The IDE debugs and loads the software onto the device. This process may take 5 to 10 minutes.
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9. Click the red X icon in the IDE to stop debugging. (See Figure 7-3.)
42 5PPDermo - IAR Embedded Workbench IDE [ESSE=T
File Edit View Project Debug Dissssembly ST-LINK Tools Window Help
DS U & 50 R|o o~ EE T @ o 4 0 |02 TROT M | ob o
ST R2HLLEZE|X
Workspace = [vaine | manQ = x Disassembly
Debug - = | Goto -
i P /* We !:-Eed to E&E-:uta Add a function to process the command line */ = D\sassemb\y -
/* to the BTPS Scheduler. £
B@SPPDemo . v if(BTPS_AddFunctionToScheduler (ProcessCharacters, NULL, 200)) J=olics o BU=U;
|8 L3 Application = { int main{void)
|- [ Bluetopia /* Add the idle function (vhick dstermines if LEM3 may be = i
B CIsTMIz_ 5t /*% entered) to the scheduler. ) main e S s s
L@ 1 output if (BTPS_AddFunctionToScheduler (IdleFunction, NULL, 0)) L 0xB016358: Oxk
= { HAL ContigursHa
/% Toop forever and execute the scheduler. s 0x801635a; Oxf
while(l) MainThread()
=l ¥ 0x801635e: Oxi
BIFS ExecuteScheduler(): ToggleLED(NT
! 0=8016362: D=2
L 0=8016364: Oxf
) BTFS. Delay(l
. } 0x8016368: 0x2
0x801636a: 0xt
! 0x801636e: Dze
ion entry point. This function */ IE UpdateHCICallbackT
e i % 0=8016370: Oze
SPRDems i i o, o S T W | A
| Log ~

Wved Jul 01, 2015 11:15:20: 112832 bytes downloaded into FLASH and verified (14.03 Khytes/sec)

Wed Jul 01, 2015 11:15:20: Loaded debugee: CATHConnectivitACCZ5EX BT\CC256x STM3Z Bluetopia SDKw4 0.2 1\NaOS\STM3240G-EVAL Sampleg\SPPDemo\No 0 S\EWARM\DebughExe\SPPDema.out
Wed Jul 01, 2015 11:15:20: Software resetwas performed

Wed Jul 01, 2015 11:18:20: Target reset

=l

Debug Log [Buld

B

Debug Log

»

Figure 7-3. Debugging Screen
10. Disconnect the STM3240G-EVAL.

11. Reconnect the STM3240G-EVAL.
12. Press Reset on the STM3240G-EVAL device.
13. Click the GO button in the IAR (see Figure 7-4).

4§ SPPDemo - IAR Embedded Workbench IDE

File Edit View Project Debug Disasser

D& &

— T

g ‘ =& L
Workspace
lr

Figure 7-4. The GO Button
Keil

1. Navigate to C:\TI\Connectivity\CC256XBT\CC256xSTM32BluetopiaSDK\v4.2.x.x to open the workspace.
2. Select one of the following samples:

* For NoOS, navigate to \NoOS\STM3240G-EVAL\Samples\ for a list of samples.

* For FreeRTOS, navigate to \FreeRTOS\STM3240G-EVAL\Samples\ for a list of samples.

3. Select the demonstration to load onto the device. (This example uses SPPDemo.)
4. Navigate to NoOS.

Note
For RTOS, navigate to FreeRTOS.
5. Navigate to RVMDK in the list.
6. Click SPPDemo.uvproj.
Note
Keil yVision4 opens.
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7. Select Debug or Release Configuration from the drop-down menu. (For this example, select Debug [See
Figure 7-5].)

d CA\Platfroms\STM32\Checking_sync\NoOs\STM3240G-EVAL\Samples\SPPDem K\SPPDemo.uvproj - uVisond

N@d@| 4 28
PO BB e |
i
= 53 SPPDemo_Debug
=7 Application
® ] Bluetopia
@ 5 STM32_StdPeriph_Lib
@] Libraries

L85 8 8] iF s )@ rovcromre 3

Figure 7-5. Debug Drop-Down Menu
8. Right-click SPPDemo_Debug in the project sidebar.
9. Select Build target to build the code. (See Figure 7-6.)

Note
Figure 7-7 shows the output when built correctly.

M CAthConnectivit/\CC25 256x STM: ) £V
File Edit View Project Flash Debug Peripherals Tools SVC5 Window Help

NBd@| 4 ai]o0] - [PRRR|EEELD s (3 2@]0 06 &|ET R
cEEe K| b2

£ | %| SPPDemo_Debug

{77 Applicati X Options for Target ‘SPPDemo_Debug'...
Bluetopi
7 STM32.5 Open File

@-{77 Libraries Open List File

Open CMiNConnectivity\CC256X BT\CC256x STM32 NoOS Bluetopia SDK\w4.0.1.3\5TM3240G-EVAL\Samples\SPPDemo\NoOS\RVMDK\SPPDemo.map

Rebuild all target files
% Build target EF:
Translate File

5 stop build

Add Group...
Add Files to Group...

Remove [tem

&% Manage Components...

Izl Show Include File Dependencies

Figure 7-6. Building Target

Note
After a few minutes, the build process finishes and builds a .axf file. Each time you change the
configuration, you must build a new .axf file.

Buitd Output

Build target 'S5FPDemc Debug!'

linking...

Program Size: Code=107948 RO-data=9972 BEWN-data=4le ZI-data=28752
FromELF: creating hex file...

T o ADebugiObjectsh. . \S5EFDemo.axf™ 0 rar {2}, 0 Warning(=}).

Figure 7-7. Build Output
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10. Choose Debug mode or Release and Debug modes.

* For Debug mode only:

a. Select Start/Stop Debug Session to start loading the profile on the STM32 device and to work in
Debug mode. (See Figure 7-8.)

CAt\Connectivit\CC256X BT\CC256x STM32 NoOS Blustopia SDK\Ww4.0.1.3\5TM3240G-EVALASa

Project

File Edit View Project Flash Peripherals  Tools  SVCS

-84 SPPDemo_Debug
E-{77 Application
: {77] Bluetopia

-7 Libraries

7-{7 STM32_StdPeriph_Lib

Window  Help
i | @ Start/Stop Debug Session Ctrl+F5
$% | spPD 85 Reset cru
B8 5 gun F5
_ Stop
{'} step F11
f}* Step Over F10
{¥ Step Out Ctrl+F11
{} Runto Cursor Line Cirl=F10
Show Mext Statement
Breakpaoints... Ctri+B
Insert/Remove Breakpoint Fa
Enable/Disable Breakpoint Clrl+F8
5 Disable All Breakpoints
&% Kill All Breakpoints Ctrl+Shift+F9
OS5 Support
Execution Profiling
Memory Map...
Inline Assembly...
Function Editor (Cpen Ini File}..,

Figure 7-8. Debug Mode

)

Note

The loading process completes in a few minutes.

b. Stop the debugging session

from the Debug drop-down menu.

Note

The profile loads on the STM3240G-EVAL board.

c. Unplug the device.

d. Plug the device in again to start working with it.
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For Release and Debug modes:
a. Click LOAD to start loading the profile on the STM32 device. (See Figure 7-9.)

Note
The loading process completes in a few minutes.

The profile loads on the STM3240G-EVAL board.

b. Unplug the device.
c. Plug the device in again to start working with it.

ﬂ CATI\Connectivity\CC256X BT\CC256x STM32 Bluetopia SC
File Edit View Project Flash Debug Peripherals

=a" N1 B9 | | B
2204 Wi SPPDemo_Debug B 2
Project 2 G 1#] Mainc

Figure 7-9. Release and Debug Mode

7.1 Flashing the Bluetooth Code
STSW-LINKO004
You can use the STSW-LINKO0O04 utility to flash the software when you have created the binary file through IAR

or Keil.

To flash the software, do the following:

1.

Open the file from the File drop-down menu.
2. Select the demonstration to load on the device. (This example uses SPPDemo.)

For NoOS, navigate

to C:\TI\Connectivity\CC256XBT\CC256xSTM32BluetopiaSDK\v4.2.x.x\NoOS\STM3240G-

EVAL\Samples\SPPDemo\NoOS\EWARM\Debug\Exe.
For FreeRTOS, navigate

to C:\TI\Connectivity\CC256XBT\CC256xSTM32BluetopiaSDK\v4.2.x.x\FreeRTOS\STM3240G-

EVAL\Samples\SPPDemo\FreeRTOS\EWARM\Debug\Exe.

3. Select a bin file. (This example uses SPPDemo.bin.)

14
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4. Click Program & Verify... from the Target drop-down menu. (See Figure 7-10.)

r | P
U, STM32 ST-LINK Utility el
File Edit View [ Target | ST-LINK  Bxernal Loader Help :
:__'é H w { Connect
iy Disconnect CTRL+D Device Information |
i |
3 Erase Chip CTRL+E Device |
Address:  0x08( . e Device ID
= FeeEant Revision ID |
| Device Memory | Fi Erase Bank2 Flash size ||
[[5PPDemo.bin], File ¢ Erase Sectors...
Address ASCT =
R ] Progr: = =
000000000 Ry Sy ol
e Program & Verify... CTRL+P o =
000000010 S TR
0x00000020 BlankCheck L e”
0x00000030 Compare device memory with [SPPDemo.bin] = mT..}=
00000000 | Qption Bytes..  CTRL+B U
000000050 EE ;%
0x00000060 MU Core b e
000000070 Automatic Mode... L T
= = o Soei
NN Settings... CTRL:S i B -
« pr— »
11 1:36:04 : [SPPDemo.bin] opened successfully.
Disconnected Device ID : Fore State : Mo Memory Grid Selected 1;
|| T ot TR ——— | eclbass it SR |

Figure 7-10. Program and Verify

Note
The information for your device shows.
5. Ensure the values in Device Information changed to your device information.
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6. Press Start. (See Figure 7-11.)
B, STM32 ST-LINK Utility . = | EH s
File Edit View Target ST-LINK:@ ExternalLoader Help
Hd @232 @5
Memory display Device STM32F 40 /F41xx
Address:  0x08000000 ~ Size: %1000 Data Width: 32bits = el | 0T
Revision ID RevZ
=z Flash size 1MBytes
De
[sFR
Address 0 4 8 C ASCI -
000000000 20008CAS 0801B475 0801B6EB1 0801B6BS i S TR g P T L.
(00000010 0801B6EY 0801BGED 0801B6C1 00000000 N..%TL AT
(00000020 00000000 00000000 00000000 OBOIEBES  [Lousiacsias AT,
0x00000020 0801B6CY 00000000 0801BSCD | 08003DAD  ET...... in.-=..
0x00000040 0801BSD1  0801BGDS  0801BGD9  (0B0LBGDD  RT..07..07..¥7..
(00000050 0801B6EL 0801BGES 0801B5EY 0801BGED al..an..én..itm..
(00000060 0801B6F1 0801BGF5 0801B6F2 QEpREED. S8 ALl id - 5
Download [ SPPDemo.bin | Y
(00000070 0801B701 0801B705 0801B709 08
000000080 0801B711 0801B715 0801B719 08 Start address - (x08000000
| 11 |
T e Fiepath  : CATIConnestiviy\CC256 BTACC258 STM32 Blustopia
11:05:03 : STLINK Firmware version : V211750 {Meed Update) ‘erification
e i (@ Yerify while programming (71 Werify after programming
11:05:02 : Connected via SWD. Click "Start" to program target.
11:05:03 : Connection mode : Normal,
11:05:03 : Debug in Low Power mode enabled.
11:05:03 : Device ID:0x413 L
11:05:03 : Device flash Size : 1MBytes [ Reset it :
11:05:03 : Device family :5TM32F 40w /F4 1 il sttt pRogkamng
- -Start _Eanc:el
bebug in Low Power mode enabled. bevice ID:0x413 - -

Figure 7-11. Start Download

Note

The command window displays Verification...OK. (See Figure 7-12.)

T - CagF T e

11:05:03 ; Cn:unnen:teEI via SWD,

11:05:03 : Device ID:0x413

11:08:00 : Verification...OK

11:05:03 : Connection mode : Marmal.
11:05:03 : Debug in Low Power mode enabled.

11:05:03 ; Device flash Size : IMBytes
11:05:03 : Device family :STM32F40m0x/F41xx
11:08:00 : Memory programmed in 55 and 211ms,

bebug in Low Power mode enabled.

Device ID:0x413

Figure 7-12. Verification...OK
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Applications

8 Applications

The dual-mode Bluetooth stack on STM32F4 MCUs includes a sample application directory for NoOS and
FreeRTOS with source code that demonstrates TI's dual-mode Bluetooth stack. These simple, command-line

sample applications display a list of available commands. Table 8-1 lists the available profiles for Bluetooth SDK.

Table 8-1. Table of Available Profiles for Bluetooth SDK

Profile Role FreeRTOS NoOS EM Platform
A3DP Demo_SNK Sink IAR IAR STM3240G-EVAL
Controller Keil Keil
A3DP Demo_SRC Source IAR IAR STM3240G-EVAL
- Target Keil Keil
Server IAR IAR
ANP demo il Kol Kol STM3240G-EVAL
Source IAR IAR
AUD demo Sink Kol Kell STM3240G-EVAL
FMP demo Target IAR IAR STM3240G-EVAL
Locator Keil Keil
CSCP demo Server IAR IAR STM3240G-EVAL
Client Keil Keil
HFP demo Audio gateway IAR IAR STM3240G-EVAL
Hands-free unit Keil Keil
HFPAG demo Audio gateway IAR IAR STM3240G-EVAL
Hands-free unit Keil Keil
HID demo Host IAR IAR STM3240G-EVAL
Device Keil Keil
HOGP demo Host IAR IAR STM3240G-EVAL
Device Keil Keil
HRP demo Collector IAR IAR STM3240G-EVAL
Sensor Keil Keil
HSP demo Audio gateway IAR IAR STM3240G-EVAL
Headset Keil Keil
HTP demo Collector IAR IAR STM3240G-EVAL
Thermometer Keil Keil
iBEACON demo Server IAR IAR STM3240G-EVAL
Client Keil Keil
MAP demo Server IAR IAR STM3240G-EVAL
Client Keil Keil
PASP demo Server IAR IAR STM3240G-EVAL
Client Keil Keil
PBAP demo Server IAR IAR STM3240G-EVAL
Client Keil Keil
Monitor IAR IAR
PXP demo Reporter Kol Kol STM3240G-EVAL
Device A IAR IAR
SPP demo Dovie & Kol Kol STM3240G-EVAL
SPPDMMulti demo Server IAR IAR STM3240G-EVAL
Client Keil Keil
SPPLE demo Server IAR IAR STM3240G-EVAL
Client Keil Keil
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9 Classic Bluetooth Sample Applications

AUD Demo
» Lets you use the advanced audio distribution profile (A2DP) to stream high-quality audio over Bluetooth.

Note

The AUD Demo uses the AUD module of the ti dual-mode Bluetooth stack. AUD implements the
non-assisted A2DP profile and the Audio/Video Remote Control Profile (AVRCP).

» Supports the sink role only.
» Visit the AUD demonstration application wiki for instructions for this demonstration.

A3DP Sink Demo

* Lets you use the assisted advanced audio distribution profile (A3DP) to send stereo audio over Bluetooth.
» Visit the A3DP demonstration sink wiki for instructions for this demonstration for the sink role.

A3DP Source Demo

* Lets you use the assisted advanced audio distribution profile (A3DP) to send stereo audio over Bluetooth.
« Visit the A3BDP demonstration source wiki for a instructions for this demonstration for the source role.

HFP Demo

* Lets you use hands-free profile (HFP) to provide remote control and voice connections over Bluetooth to a
mobile device.

* Supports the hands-free role.

» Visit the HFP demonstration wiki for instructions for this demonstration.

HFPAG Demo

» Lets you use the hands-free profile on an embedded device.

» Connects a headset or speaker phone with a mobile device to provide remote control and voice connections.

» Supports the hands-free and audio-gateway roles.

» Provides two applications that demonstrate the audio-gateway and hands-free roles of the profile,
respectively.

» Offers audio routing to the STM3240G-EVAL board DAC for the hands-free application and audio-gateway
role application.

» Visit the HFPAG demonstration application wiki for instructions for this demonstration.

HID Demo

» Offers a demonstration of the human-interface device (HID) profile that enables a host to connect and control
a HID device.

» Visit the HID demonstration wiki for instructions for this demonstration.

HSP Demo

» Lets you demonstrate the headset profile (HSP) on an embedded device.

* Connects a headset or speaker phone with a mobile device.

» Connects an audio gateway with a headset device to provide basic control and voice connections.
» Visit the HSP demonstration wiki for instructions for this demonstration.

MAP Demo

» Lets you exchange message objects over Bluetooth.
» Visit the MAP demonstration application wiki for instructions for this demonstration.

PBAP Demo

* Lets you exchange phone book objects over Bluetooth.
» Visit the PBAP demonstration application wiki.

SPP Demo

» Shows how to use the serial port profile (SPP) module.

Shows how to handle the different callback events.

Lets you interface with a remote SPP client or server.

Visit the SPP demonstration application wiki for instructions for this demonstration.
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10 Classic Bluetooth + Bluetooth Low Energy Applications

SPP + SPPLE Demo

» Shows how to use Low Energy (LE) and the GATT profile.

» Emulates using SPP over LE using the GATT profile.

¢ Acts as a LE master and LE slave.

* Shows how to use the SPP module.

» Shows how to handle the different SPP callback events.

* Acts as either an SPP server or SPP client

* Uses the same command for SPP as the SPP demonstration.

» Visit the SPP + SPPLE demonstration wiki for instructions for this demonstration.

SPPDMMulti Demo
» This application is based on the SPP + SPPLE Demo application and demonstrates how to use the chosen
features from Bluetooth specification 4.1 and Bluetooth specification 4.2:
— LE Dual Mode Topology: Connect in classic Bluetooth and Bluetooth Low Energy to the same device.
— LE Link Layer Topology: Support multiple simultaneous roles; that is, Peripheral and Central.
— L2CAP LE Connection Oriented: Support LE Credit Based Flow Control Mode.
— LE Ping: Used to verify presence of the remote Link Layer. In addition, can be used to verify message
integrity in the LE ACL by forcing the remote device to send an LE ACL packet that contains a valid MIC.
— LE Low Duty Cycle Advertising: Designed for cases where reconnecting with a specific device is required,
but time is not of the essence or it is not known if the central device is in range or not.

— 32-bit UUID: Register services with aliases that are represented as 32-bit values instead of 128-bit UUIDs.

— LE Secure Connections: Enhance the LE Security Manager with public key Elliptic Curve Diffie-Hellman
(ECDH) key generation.

* The application lets the user establish connection between multiple BLE devices using the SPPLE custom
service, send Bluetooth commands, and exchange data over BLE. This application also shows how to use
the SPP module and how to handle the different SPP callback events. The application acts as either an SPP
server or an SPP client and exposes the same command set for SPP as the SPPDemo.

* For a step-by-step demonstration of how to run this application, visit SPPDMMulti demo wiki.

11 Bluetooth Low Energy Applications

ANP Demo

» Shows how to use low energy (LE) and the GATT profile.

* Implements the alert notification profile (ANP) using the GATT profile.

* Acts as an LE master and LE slave.

* Forinstructions for this demonstration, see the ANP demonstration wiki.

iBEACON Demo

* Provides location-based information and services for iOS devices.

« Has server and client roles.

» Lets the user use a console to use Bluetooth Low Energy to advertise specific data that can be read by the
client.

HRP Demo

* Shows how to use low energy (LE) and the GATT profile.

* Implements the heart rate profile (HRP) using the GATT profile.

* Acts as an LE master and LE slave.

* Forinstructions for this demonstration, see the HRP demonstration wiki.

HTP Demo

* Shows how to use low energy (LE) and the GATT profile.

* Implements the health thermometer profile (HTP) using the GATT profile.
* Acts as an LE master and LE slave.

* Forinstructions for this demonstration, see the HTP demonstration wiki.
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PASP Demo

» Shows how to use low energy (LE) and the GATT profile.

* Implements the phone alert status profile (PASP) using the GATT profile.
* Acts as an LE master and LE slave.

* Forinstructions for this demonstration, see the PASP demonstration wiki.

HOGP Demo

» Shows how to use low energy (LE) and the GATT profile.

* Implements the human-interface device (HID) using the GATT profile.

» For instructions for this demonstration, see the HOGP demonstration wiki.

PXP Demo

* Shows how to use low energy (LE) and the GATT profile.

* Implements the proximity profile (PXP) using the GATT profile.

« For instructions for this demonstration, see the PXP demonstration wiki.

FMP Demo

» Shows how to use low energy (LE) and the GATT profile.

* Implements the find me profile (FMP) using the GATT profile.

* Acts as an LE master and slave.

* Forinstructions for this demonstration, see the FMP demonstration wiki.

CSCP Demo

» This application shows how to use LE and the GATT profile establish connection between two BLE devices
with the cycling speed and cadence service (CSCS), notify measurements and change the sensor location
and cumulative wheel value in the Speed Cadence (SC) Control Point.

» For a step-by-step demonstration of how to run this application, see the CSCP demo wiki.

12 Revision History
NOTE: Page numbers for previous revisions may differ from page numbers in the current version.
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